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1 Loading and Characterizing an Image

Goals: The very basic - load an Image, get its properties and intensity histogram,
convert to 8-bit and save the Image

e Open the image DIC.zvi

e Use Fiji to find the following Image properties: Type, Resolution, Width and
Height [Image—Show info].

e Show the distribution of pixels as function of intensity (Histogram) by
[Analyze—Histogram].

e Press the “Live” button which shows the changes in the histogram values as the
image changes.

e Convert the image type from 16bit gray scale to 8bit gray scale
[Image—>Type—8-bit].

e Save the converted image [File>Save as—Tiff].

2 Understanding Bit-Depth and Scaling

Goals: Understand what happens when you convert from 16 bit to 8 bit, and how to do
it correctly, use intensity profile along a line to view the scaling effect.

e Open the image [EMBL—Samples—m51.tif].

Note that EMBL which is on the very right side of the menu is a plugin that does
not come with the default Fiji Installation.

e Use the line tool and draw a line (called “line ROI”) through the bright spot in the
middle of the image. Then do [Analyze—Plot Profile...]. You will get graph of the
intensities along the line.

e Make sure that “Scale When Converting” is ticked in
[Edit—>Options—Conversion]

e Convert the image type from 16bit gray scale to 8bit gray scale
[Image—Type—8-bit]. Do [Analyze—Plot Profile...] again. Compare the previous
profile (16-bit) and the new profile (8-bit). Do they look similar? What are the
differences?



Save the line ROI you created by pressing “t” or clicking “add” in the ROI
manager. (You can open the ROI manger with [Analyze—Tools—ROI
manager...])

Now untick “Scale When Converting” in [Edit—>Options—Conversion]

Open the 16-bit image again; Convert to 8-bit image again. Does the image
look similar? What happens?

Find the ROI manager and click on the ROI nhumber you stored above. Same line
ROI will appear in the new image. Then do [Analyze—Plot Profile...], note the
differences in the line profile this time.

3 Intensity and Contrast Enhancement

Goals: Compare images of under/over exposure and good exposure. Notice the
maximum value, and saturated pixels. Experience Adjust Brightness/Contrast, and learn
to avoid clipping.

Open the images that were acquired in under exposure, good exposure and over
exposure conditions: Dapi_X100_001_Ex_5msec.tiff,
Dapi_X100_001_good.tiff, Dapi_X100_ 001 Ex_100msec.tiff.
Display the intensity histograms of the three images with [Analyze—Histograms]
and notice the differences in intensity distribution between the images.
Save the histograms values to files as “Histogram#” (#=1,2,3). You can do
this using the "List” button followed by [File—»Save As...] from the opened table,
or using the “Copy” button, and pasting into excel table.
Check for saturated pixels using [Image—Lookup Tables—HiLo], which shows
saturated pixels in red and minimal value pixels in blue.
Change the image contrast using [Image—Adjust—Brightness/Contrast...], The
black diagonal line on the histogram corresponds to the LookUp Table (LUT) of
the image on the screen. Pixel value in x is translated to the grey value on the
screen (Brightness on the screen is y-axis).

o Check how the four sliding bars under the graph change the slope and

position of the LUT.

o Check what the “Auto” button is doing.

o Setthe same LUT for all the three images using the “Set” button
Open the file gel_inv.tif from [EMBL—Samples]. Change the image contrast
The original image is not changed at this point. When you push the “Apply”
button the original image is changed.

Question: what is the problem if we set minimum= 80 and maximum 200 ?

Note: Avoid Scaling of images in which you want to quantify the intensity.



4 Color Display

4.1 Look-Up Tables (LUT)
Goals: Understand and experience with different lookup tables, display the calibration

bar.

Look-Up Tables controls the way the matrix of numbers is displayed on the screen. The
default look-up table is the gray scale that assigns black to white from 0 to 255 in the 8-
bit image. However, LUTs can be colored; a colored LUT is called pseudo-color.

Open the file gamma.tif

Try displaying the file with different LUTs by choosing from the LUT menu on the
icon toolbar or from [Image—Lookup Tables].

You can show the color bar by [Analyze—Tools—Calibration Bar...].

Save the image [File>Save as—Tiff].

4.2 Multi-Channel Images
Goals: Learn to split/merge channels, work with composite image and channels tool.

Open the image [EMBL—Samples—RGB_Cell.tif] or FlorecentCells.tif. Split
the color image to 3 different images [Image—Color—Split Channels].

Merge back the images with [Image—Color—Merge Channels...].

In the dialog window, choose an image name for each channel. Uncheck “Create
Composite” and check “keep source images”. Then try swapping color
assignment to see the effect.

Repeat the channel merge but now check “Create Composite”. Resulting image
is a three-layer stack and each layer corresponds to one of R,G or B. Each layer
can be processed individually. You can now switch on/off each channel using
[Image—Color—Channels Tools]. Check the different modes (Composite / Color
| Grayscale).

Try changing the different channels intensity to optimize the image.

Option: The ImageQuad*.tif files are 4 channels of the same cell, make a
composite of them with the channels pseudo-colored and scaled as you think
best displays them and export as 24-bit RGB file. Use [Image—Color—Stack to
RGB] or [Image—Type—RGB Color] to convert the composite image into 24-bit
RGB image.



4.3 Color Images (optional task)
Goals: Work with histological data, learn about different color modes (RGB/HSB). Use
Colour Deconvolution for color separation.

In some cases like histological stained images, using other color spaces is more
suitable.

Open H&E.tif, we would like to separate the red cells from and purple ones.

Try splitting the channels using [Image—Color—Split Channels], as you did
before.

Reopen the image, extract the Brightness channel from the HSB: convert to HSB
Stack [Image—Type—HSB Stack], go to the third channel and duplicate it: Go to
the third channel using the slider, use [Image—Duplicate] , don’t tick “Duplicate
entire stack”. Does this look better?

The Colour Deconvolution plugins implements stain separation. The plugin
provides a number of "built in" stain vectors which were determined
experimentally. Reopen the image, do [Image—Color— Colour Deconvolution].
Select “H&E” from the vectors popup menu.

Note: while colour deconvolution might be useful to segment immunostained
structures, attempting to quantify DAB intensity using this plugin is not a good idea.
See more: http://www.mecourse.com/landinig/software/cdeconv/cdeconv.html

5 Geometrical Measurements and Manual Cell Counts

Goals: Basics of manual measurements - Use different selection tools: Line, Angle,
Polygon, and Elliptical. Learn to set measurements and measure length, angle, area
and perimeter. Count cells manually.

Open “Counts.zvi”

Set the features to measure using [Analyze—Set Measurements...], select Area
and Perimeter.

Note: the “limit to threshold” option. If a threshold is set in the image, the
measured area will be restricted to the pixels whose values are above the
threshold.

Use Line selection to measure distances between cells.

Use Angle Tool to measure the angles of the cell in the lower side of the image.
Note that while you draw, the length of the line and the angle appear in the status
bar. To add the measure to the Results table use [Analyze—Measure], they will
appear regardless of the measures you selected with Set Measurements.


http://www.mecourse.com/landinig/software/cdeconv/cdeconv.html

e Use Polygon selection and Elliptical selection to measure area and perimeter of
the cells.
e Manually count the nuclei using Point Tool (with Shift+Click).
Use alt+click to remove a point.
Note that the number of cells appears in the status bar when you add a new
point.
Use [Analyze—Measure] to find the number of cells. Save the measurements
file.
Tip: Double click Point Tool, select Auto-Measure and Add to ROl Manager and
check their affect.

6 ROI, Calibrations and more Measurements

6.1 Intensity Measure
Goals: Measure Intensity, Save ROI to file

e Open the file GoldParticles.tif. Use [Analyze—Set Measurements...] to select
the following measurements: Area, Mean gray value, Min & max gray value,
Perimeter.

e Set ROI around the one of the gold particles (use +/- to zoom in and out).

e Measure the desired features using [Analyze—>Meausre]

e Save the selected ROI as “Roi1” using [File—>Save as—Selection], and the
measurements as “Results_Roi1” using [File—>Save As...] from the Results
window. By default the file is saved in excel format.

Tip: you can save the column headers and row numbers using [Results—Options...]
from the Results table menu.

6.2 Calibration
Goals: Calibrate to physical units, show scale bar, load ROI from file.

e Set the correct calibration of the file: draw a line along the green 100nm scale
bar.

e Select [Analyze—Set Scale], in the new window you should set the known length
(100) as “distance”, and the new units (nm) as “unit of length”.

e Show the scale bar on the upper left side of the image using
[Analyze—Tools—Scale Bar...]

e Save the image [File>Save as—Tiff].

Note: that if you want the new calibration to affect all displayed images (and all
the new ones to be displayed); you should check the “Global” option.



Note also: that every image opened using Bio-Formats plugin, is already
calibrated using the information in the file header, but if the Global Scale is set, it
will overcome the built-in calibration. To remove this global scale, click the “Click
to Remove Scale”.

Repeat the measurement you did in 6.1. There is no need to draw the ROI again.
Use [File—Open] to open the file “Roi1.roi”. Check the new measurements and
compare them with the uncalibrated results.

Close the image and clear the Results table by [Analyze—Clear Results].

6.3 Working with ROl Manager

Goals: Learn how to add ROI to the ROI Manager, make measurements on multiple
ROls at once, save all ROIs together, apply ROIs to different image to measure
intensities from a different channel.

Open the files Image_Quad_B.tif and Image_Quad_DAPI.tif.

Draw 3 ROIs around the 3 nuclei in the middle of Image_Quad_DAPI, and keep
them using ROl Manager [Analyze—Tools—ROI Manager...]. Add each ROI
separately to the ROl Manager by Clicking “Add” in the ROl Manager, or
[Edit—>Selection—Add to Manager] when you are done with the ROI selection
Tip: You can also use the shortcut “t” to do so, it will also open the ROl Manager
if it is not open yet.

Check the “Show All” option in the ROl Manager.

Change the names of the ROIs to nucl, nuc2 and nucs3.

Click the image to make it active and then measure the same parameters as
before using the “Measure” button in the ROl Manager. To measure all the ROls
at once make sure you highlight all of them.

Save the Results as “Results_ DAPI” and clear the Results table.

Save the whole set of ROIs by [More—Save] in the ROl Manager.

You can later upload the saved ROIs by [More—Open] in the ROI Manager.
Measure the same features from the other channel (Image_Quad_B): activate
the desired image, uncheck “Show All” in the ROl Manager and check it again.
The ROIs will be shown now in the new image, and you can measure using the
“‘Measure” button in the ROl Manager window.

Save the Results as “Results_B” and clear the results table.



7 Automatic Segmentation

Goals: Perform intensity based segmentation using threshold. Separate touching
objects with watershed. Find and count cells using Analyze Particles. Save the
measurements into excel file, overlay cells’ boundaries on the original image and save
as new file.

e Open EpithelialCells.tif. We will use Intensity based segmentation to find the
exact boundaries of the different cells.

e Duplicate the image by [Image—Duplicate] (or Ctrl+Shift+D), change the name of
the duplicated image to “Orig”. Switch back to the original image window.

¢ Note that the file type is RGB, In order to use intensity segmentation we need to
convert the file to grayscale, by separating the channels and selecting the green
channel.
Question: what is wrong in converting the file to grayscale using
[Image—>Type—>8-bit]?

e Athreshold is an Intensity value above which is an object, below which is
background. Do [Image—Adjust—>Threshold...] , check Dark Background, switch
between the different automatic threshold selection methods to see their effect.
Change the minimum and maximum thresholds using the sliders to see their
effect.

Select Otsu or Intermodes method, and push the “Apply” button. This will
generate a binary image of the segmented cells.

e Separate touching objects using [Process—Binary—Watershed]

e Automatically count the objects using [Analyze—Analyze Particles].

You can detect cells of desired size and circularity by setting the proper values.
Circularity values are from 0-1, where 1 is an ideal circle.

You can use the Show popup menu to choose between several options of
displaying the results.

Choose Display Results to add the cells’ measurements to the Results table. You
can clear previous content of the Results table by checking clear results. You can
also create a summary table by checking the Summarize option. Choosing the
Add to Manager option, will let you browse through the detected cells.

When measuring the size or intensity of the cells, it is a good practice to ignore
cells which only part of them appears in the image. You do this by checking
Exclude on edges
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How many cells did you get? Are all of the real cells? Try to ignore the very
small ones.

Tip: You can measure the size of a given object in the binary mask by choosing the
Wand Tool, clicking on the object and using [Analyze—Measure], do this on several
small, big and normal objects to get the idea of the desired size values.

e Save the Results and Summary tables into excel file [File—>Save As...] from
the Results window.
e Save your segmentation results:
o Select the image you duplicated (“Orig”). Use “Show All” in the ROI
Manager. Save the file with the overlay, look at the saved file. Press
“Flatten” on Roi Manager (or [Image—Overlay—Flatten]) [and repeat the
save, look at the saved file, it should include the selection overlay now.
o Save the segmentation from the ROI Manager to a file (see exercise 6.3).
e Close all the image windows [File—Close All]. Close the ROl Manger, the
Results and Summary tables.

Tip: The intensity value that appears in the Results table is based on the binary
mask that is the output of the segmentation. To measure the real intensity from the
original file, you need to duplicate your intensity file (green channel) before applying
the threshold, Open [Analyze—Set Measurements] and use Redirect to select the
image from which the intensity values will be measured.



8 Basic Automation: macro recording (optional task)

Goals: Record a sequence of operations and save them as macro file. Apply the
recorded macro to a file.

We will now learn how to record a set of commands and turn it into a macro that can be
used to repeat the operations on the same image or on other images. Later on special
commands can be added to such macros to allow for much more complicated
operations. For example to open all files in a given folder and run the same set of
operations on each image. Macro writing is beyond the scope of this tutorial.

Open EpithelialCells.tif.

Start recording your commands by [Plugins—Macros—Record...]

Duplicate the image by [Image—Duplicate] (or Ctrl+Shift+D), change the name of
the duplicated image to “Orig”. Switch back to the original image window.

Note that the file type is RGB, In order to use intensity segmentation we need to
convert the file to grayscale, by separating the channels and selecting the green
channel.

A threshold is an Intensity value above which is an object, below which is
background. Do [Image—Adjust—>Threshold...] , check Dark Background, switch
between the different automatic threshold selection methods to see their effect.
Change the minimum and maximum thresholds using the sliders to see their
effect.

Select Otsu or Intermodes method, and push the “Apply” button. This will
generate a binary image of the segmented cells.

Separate touching objects using [Process—Binary—>Watershed]

Automatically count the objects using [Analyze—Analyze Particles].

You can detect cells of desired size and circularity by setting the proper values.
Circularity values are from 0-1, where 1 is an ideal circle.

You can use the Show popup menu to choose between several options of
displaying the results.

Choose Display Results to add the cells’ measurements to the Results table. You
can clear previous content of the Results table by checking clear results. You can
also create a summary table by checking the Summarize option. Choosing the
Add to Manager option, will let you browse through the detected cells.

When measuring the size or intensity of the cells, it is a good practice to ignore
cells which only part of them appears in the image. You do this by checking
Exclude on edges

Click the “Create” button in the Recorder window. It will open a macro editor
window with all the commands you have performed.



Comment lines in Imaged Macro Language (ijm) start with “//” and appear in
green in the editor. Add a comment describing what the macro does at beginning
of the file.

Use [File—>Save] from the editor to save the macro file as “SegMacro.ijm”.
Close all the image windows [File—Close All]. Close the ROI Manger, the
Results and Summary tables.

Reopen EpithelialCells.tif

Click the “Run” button in the Macro Editor window to run the whole macro.

You can run selected lines by highlighting them in the editor window and using
[Run—Run Selected Code] from the macro window menu.

Note that if you close the Threshold window, a close() command is added to the
Recorder, this line is not needed, and will close your image, so delete it.

9 Masking (optional task)

Goals: Select specific part of the image for analysis.

Open EpithelialCells.tif and repeat the stages from exercise 8 up to (and
including) the watershed. You may use your macro for this. Comment the lines
you don’t need or use Run Selected Code.

Our goal now is to select only specific parts of the image for analysis. We will
achieve this by defining a mask and applying it the detected cells, before running
Analyze Particles.

Use one of the ROI tools to select part of the image. Run
[Edit—>Selection—Create Mask] to create a new image in which the selected area
is white and the rest is black. Note that the value for the white area is 255 and
not 1.

Option: Check what happens when you go to the image with the selection and
duplicate it.

Go back to the segmented cells image, remove the selection
[Edit—>Selection—Select None].

Run [Process—Image Calculator...], make sure that Create new window is
selected.

Select the segmented cells image for imagel and the mask as image2, and set
the operation to be AND.

Run Analyze Particles. On the result image.



Question: What will be the difference between using the mask with image
math and using the duplicated selected area?

10 Multi-Dimensional Data

10.1 Open Multi-Dimensional Data

Goals: Open one file with many images. Open image series from a folder. Play time
series. Get familiar with the concepts of stacks and hyperstack. Rearrange the images
using Stack to Hyperstack.

Open the file Neuron_3D_Time.Ilsm using [File—Open]. The file is identified as
60 frames stack. There is a slider at the bottom of the image. Play the file using
the triangle on the left side of the slider.

Check the metadata by using [Image—Show Info...]. What can you learn from
this? What is wrong with the opened file?

Reopen the file using [plugins—Bio-Formats—Bio-Formats Importer...]. Bio-
Formats reads correctly the information from the file header and the file is
identified now as Hyperstack of 6 slices * 10 time-points, and there are two
sliders below the image. Check again the metadata.

Play the file now. You can stop the animation by clicking the play icon again or by
clicking with the mouse at any point in the image.

You can control the speed of the animation using
[Image—Stacks—Tools—Animation Options...] There is also a shortcut icon
named “Stk” on the right side of the toolbar which list some useful stack
commands.

You can move between slices (z-dimension) using the forward/backward arrows
or the < > keyword buttons.

In some cases multidimensional is not saved within a single file but as other
forms such as multiple single image frames like the files in zt_series folder. Use
[File—Import—Image Sequence...] to import all 60 images. Use
[Image—Hyperstack—Stack to Hyperstack] to reorder the file by setting correct

values of “Channels”, “slices” and “Frames”.

Tip: The order of the stack dimension is fundamental as it effects the order in which
the images will appear. “XYCZT” is a typical order but many microscope companies
and software do not follow this typical order. You can control this using the “order”
field in “Stack o Hyperstack”.

Tip: You can use “Import Image sequence” to select subset of the files using the
field “file name contains”. Try to open only the files which refer to the 3" slice.



10.2 Edit Stacks
Goals: Basics of stack editing — select part of a stack.

Tools for stack editing are available under the menu tree [Image—Stack—Tools] and
[Image—Hyperstack—Reduce Dimensionality]

e Open Neuron_3D_time.lsm as Hyperstack.

e Select all time points of the 4" slice: move the slider to the 4sth slice. Run
[Image—Hyperstack—Reduce Dimensionality], untick Slices and tick Frames.
Make sure Keep Source is ticked.

e Save the image [File>Save as—Tiff].

e Select slice 2-4, and Frames 5-10 of the stack: Go back to the original file, run
[Image—Duplicate...]. Tick Duplicate hyperstack, and select the desired slices
and frames.

e Save the image [File>Save as—Tiff].

10.3 Visualization

Goals: Get familiar with different methods to look at multi-dimensional data — montage,
color coding of time series, projections of volumetric data to 2D image using Z project,
get impression of the 3Dness of the data by 3D project. Orthogonal slices and 3D
viewer

e Montage: you can display all the slices (or frames) in the same window using
[Image—Stacks—Make Montage]. Open the file Maize_stack.tif, display every
4™ slice and label the slices.

Open the file mitosis.tif using [File—>Open Samples->Mitosis]. This is a 5D
hyperstack, and make montage will not handle it. Duplicate only the data of the
3" slice. Create montage of every 4" frame. You can control the displayed colors
using the channel tool. Save the montage.

e Color coding: The color coding is not limited to the dimensions in channels, but
also for slices (Z) and time points (T). By assigning a color that depends on the
slice number or time points, the depth information within a Z-stack or a time point
information with in a time lapse movie could be represented as a specific color
rather than by the position of that slice or frame within image stack.

Open [EMBL > Samples > TransportOfEndosomalVirus.tif]. Apply the color
coding to this time-lapse movie [Image—HyperStacks—Temporal-Color Code]. In
the dialog choose a color coding table from the drop-down list. Principle of the
coding is same as the look-up table, and only the difference is that the color



assignment is adjusted so that the color range of that table fits to the range of
frames. Save the image [File»>Save as—Tiff].

Projections: Projection is a way of decreasing an n-dimensional image to an n-
1-dimensional image. For example, if we have a three dimensional XYZ stack,
we could do a projection along Z-axis to squash the depth information and
represent the data in 2D XY image. We lose the depth information but it helps us
to see how the data looks like.

Open the files Urchin_StackRGB.tif, Maize_stack.tif and, EMBL—
Samples—>mitosis_anaphase_3D.tif]. Try the different types of projections by
[Image— Stack—Z projection...]. See what works well for each dataset. Look at
the histogram of the projections.

Note: for brightfield use minimum projection (ie the interesting things are the
darkest structures, in fluorescence the brightest).

You can use projection series from different angles to appreciate the 3Dness of
the data using [Image—Stacks—3D Project...]. Try this on
Urchin_StackRGB.tif.

Save the image [File>Save as—Tiff].

Orthogonal Slices: When we open a stack we can scroll throughthe Zand T
dimension. To scroll through X or Y, we use “Orthognlal View”. Open the file
Maize_stack.tif. Run [Image—Stack— Orthogonal View]. Running this command
will open two new windows at the right side and below the stack. These two new
windows are showing YZ plane and XZ plane. Displayed position is indicated by
yellow crosses. These yellow lines are movable by mouse dragging. Try scrolling
through each axes: x, y and z.

3D Viewer: Instead of struggling to visualize 3D in 2D planes, we could also use
the power of 3D graphics to visualize three dimensional image data, using the 3D
viewer plugin. Try the plugin on [EMBL—>Samples—mitosis_anaphase_3D.tif],
by running the command [plugins—3D Viewer]. A parameter input dialog opens
on top of 3Dviewer window. Change the following parameters:

o Image: Choose mitosis_anaphase_3D.tif.

o Display as: Choose Surface.

o Color: Could be any color. For example white.

o Threshold: Default value 50 should work OK, but you could also try
changing it to greater or smaller values. This threshold value determines
the surface. Pixel intensity greater than this value will be considered as
object, else background.



o Resampling factor: default value (2) should be sufficient. If you change
this value to 1, then it takes longer time for rendering.In case of our
example image which is small, difference in the rendering time should be
not really recognizable.

After setting these values, clicking “OK” will render the image in the 3Dviewer
window. Try to click and rotate the object. More advanced usages are available
such as visualizing two channels or showing 3D time series as a time series of
3D graphics or saving movies. For such usages, consult the tutorial in the
3DViewer website (http://3dviewer.neurofly.de/).

You can also try [Plugins—Volume Viewer]

10.4 Movie Creation (optional task)
Goals: Save time-lapse data as avi movie

e Open the file mitosis.tif using [File—>Open Samples->Mitosis]. This is a 5D
hyperstack

e Create a movie in avi format by [File—>Save as—AVI...]. You should set the
frame rate in the pop-up window. Question: which slice is used for saving?

10.5 Measurements (optional task)
Goals: measure change of intensity over time.

e Intensity Dynamics of image sequence: Load the image
[EMBL—>Samples—stack 1703-2(3s-20s).stk]. This is a sequence of FRAP
experiment. Draw a ROI (could be any closed ROI) surrounding the area where
the photobleaching takes place. Then do [Image—Stacks—Plot z-axis Profile]. A
graph of intensity dynamics will be opened. Click the “List” button to save the
values to a file. Try this also on “Ca spikes.Ism”.

e You can do image processing (Threshold, Brightness, Contrast, Filters, ...) of the
whole image sequence using the same commands we used for a single image.
When you select the command you will be if the processing should be done on
the whole sequence.

Try adding Second ROI to measure the background, simply by making another
ROI. Do the intensity measurement again with this new ROI.

Note: When you measure the fluorescence level, it is very important to measure
the background intensity and subtract the value from the measured fluorescence.
This is because the baseline level adds offset to the measured value, so you
cannot quantify the true value.


http://3dviewer.neurofly.de/

11 Image Processing (optional task)

Note that Image processing and scaling should be done with care (to avoid being
accused of image manipulation). Make sure you know what you are doing and
document it. What is done should be done to the whole image. It is very useful as
intermediate step towards objects segmentation, be cautious with intensity
measurements.

11.1 Filters
Goals: Experience with different filters — smooth, sharpen, median, mean, Gaussian
Blur.

We will use the image processing tools from the Process menu to enhance images and
reduce noise.

e Open the files Use the files noise.tif and Sharpen.tif

e Draw a line ROI along the image, find the intensity profile along the line using
[Analyze—Plot Profile].

e You will use different filters to test their effect. The effect will be also seen in the
Intensity Profile graph, if it does not update, click the “Live” button. Save the
intensity profile using the “Save” button. After each operation get back to the
original file using [File—Revert]. Note that the operation is performed on the
active image, so make sure you select it before processing. Try the following
operations:

Smoothing: [Process—Smooth]

Sharpening: [Process—Sharpen]

Median Filter: [Process—Filters—Median...]

Averaging Filter: [Process—Filters—Mean...]

Gaussian Blur Filter: [Process—Filters—>Gaussian Blur...]

o O O O

You can also mix several operations and test their effect

Questions: What was the influence of each operation? Which one reduces the
noise? Which one enhances the structure?

11.2 Morphological Image Processing
Goals: Experience with morphological operations - Dilate, Erode, Fill Holes

We will use binary morphological operations to close structures, remove noise, and
smooth boundaries:



e Open the file [EMBL—Samples—noisy-fingerprint.tif] and
[EMBL—Samples—book-text.tif].

e Apply dilation and erosion several times using [Process—Binary—Dilate] and
[Process—Binary—Erode] and check their effect.

e Save the image [File>Save as—Tiff].

Tip: You can fill holes in structures using [Process—Binary— Fill Holes]

11.3 Background Subtraction
Goals: Experience with several options for background subtraction.

Subtraction of fixed value

e Open the image Background.tif, we will try several different background
subtraction methods

e Select area of the background using one of the selection tools, and measure it’s
mean intensity.

e Clear the selection by [Image—Selection—>Select None]

e Subtract the mean background intensity from the image using
[Process—Math—Subtract...]

e Save the image [File>Save as—Tiff].

Minimum Filtering
e Open the image again and duplicate it.
e Run [Process—Filters—>Minimum], use preview to set the Radius to remove the
small bright objects and keep only the background.
e Use [Process—Image Calculator...] to subtract the filtered image from the
original one.
e Save the image [File>Save as—Tiff].

Rolling Ball

e Open the image again.

e Open the image again. Run [Process—Subtract Background...], Set the rolling
ball radius. It should be at least as large as the radius of the largest object in the
image that is not part of the background.

This method is very similar to the one using the minimum filter, except that the
structuring element is different

Check what happens if the radius is smaller.

Save the image [File—>Save as—Tiff].



Pseudo high-pass filtering
e Open the image again and duplicate it.
e Create largely blurred image by Gaussian blur (such as with sigma of 20) and
subtract it from the original image.
e Save the image [File»>Save as—Tiff].

There are several other background subtraction methods that do not depend on
morphological processing, such as High pass filtering and Flat-field correction by
polynomial fitting. You can also use calibration slide to for background subtraction.

Tip: Hot pixel correction (few pixels with spurious intensity) can be done with
[Process—Noise—Remove Outliers], you can try it on HotPixels.tif

11.4 Segmentation
Goals: Separation of different stainings.

We will use the Trainable Weka Segmentation plugin to partition an image to different
segments according to histological staining. For more information see
http://fiji.sc/Trainable_Weka_Segmentation

e Open the file H&E.tif image.
¢ Run [Plugins—>Segmentation—Trainable Weka Segmentation]
o Using one of the ROI tools:

= Add traces of red cells to Class 1

= Add traces of purple cells to Class 2
Click “Create New Class” and name it “Background”
Trace areas representing background and add them to Background Class
Click “Train Classifier” and wait until segmentation is complete.
Click “Create Result”. The result will be an 8-bit color image, with different
colors representing each class. Save the 8-bit color image.

o O O O

12 Tracking (optional task)

12.1 Automated Tracking
Goals: Perform automatic tracking of cells over time.

We will use TrackMate plugin for tracking fluorescent cells in live cell imaging
experiment. TrackMate is designed for segmenting and tracking spot-like objects, it can



be set to deal with gap-closing events, splitting and merging. For more information, see:
http://fiji.sc/TrackMate

e Open the file “Foreskin Epidermis.lsm”. The file contains fluorescence channel
and transmitted channel.
¢ Run [Plugins—Tracking—TrackMate], and follow the instructions of every step:

o Make sure the dimensions are identified correctly in “crop settings” (all the
image) and click “Next”.

o Keep the default “LoG detector” and click “Next”.

Make sure that the correct (fluorescent) channel is used for segmentation.
Set the estimated object size and the estimated Threshold (use [Image—
Adjust—Threshold] and click “Reset” when done), and click “Next”.

o In the “initial thresholding” screen you can use “Quality” to filter out some
of the objects without displaying the results in the image. Quality is a
feature that combines Intensity and size and gives an estimate for the
fithess of the object to the defined parameters. Click “Next”.

o Select display mode, it is recommended to use “HyperStack Displayer”.
Click “Next”.

o Spot filtering: When this panel is shown the spots should be displayed on
the Image stack as purple circles of the diameter set previously. Browse
through the frames, if there are many irrelevant spots you should filter
them out at this stage, otherwise the tracking algorithm would fail. You can
select filters to reject some of the spots. Filters are added using the green
+ and are selected from the popup list. Click “Next”.

o Select a tracker: “Simple LAP tracker” prevents splitting and merging
events to be detected, while “LAP tracker” supports these options. Click
“Next”.

o Configuring “Simple LAP tracker” :

= “Linking max distance” - This value limits the spatial search range
for candidate matching spots. If you know the maximal
displacement of your object between two frames, you can put this
value here.

= “Gap-Closing max distance” — Gap-Closing enables linking two
track segments if the object disappeared (or was not detected) for
few frames. The two tracks will be linked only if the last spot of the
first track is not further away than the first spot of the second track.

» “Gap-Closing max frame gap” — this is another parameter that
controls the gap-closing algorithm. It defines the maximal number
of frames in which the spots are missing.

= Click “Next”


http://fiji.sc/TrackMate

o Tracks Filtering - The tracks should appear on the Image stack now. You
can use this screen to filter out tracks based on some features if needed.
Click “Next”.

o Display options — this step allows you control the way the results are
displayed. “Track Scheme” is an interactive tool that lets you manually edit
the tracks and performing analysis on them.

o The next step allows you to plot any kind of features as a function of
another one.

o The last panel is the Action chooser panel, that allows you to execute
simple actions on your data, such as exporting, copying, re-calculating
feature, etc...

If you are happy with the results, you can save them now. Loading the
resulting file again in TrackMate will bring you to this panel, where you can
inspect those results conveniently. [Plugins—Tracking—Load TrackMate
File].

12.2 Manual Tracking
Goals: Perform manual tracking of cells over time.

We can also use Manual Tracking to follow cells. For more information, see:
http://fiji.sc/wiki/index.php/Manual_Tracking

Open the file “Foreskin Epidermis.lsm”. The file contains fluorescent channel
and transmitted channel.

Enhance the brightness and contrast of the image. You may want to use
Composite view.

Run [Plugins—Tracking—Manual Tracking].

Make sure Show parameters is checked, and set xy calibration values.

Select a cell that you want to follow and decide which part of it you are going
track (eg: one of the black spots inside nuclei, or a corner of the cell). Move to
the frame you want to start with.

To create a new track, click the Add Track button. Make sure that the show path
option is checked.

Set the object location by left clicking the mouse in each time point. After each
click the movie will advance to the next frame. At the end click End Track.
Zooming-in may be useful here.

The Results window records various parameters about the track. Save them
using [File—>Save As...] from the Results table menu.

Question: When will you use manual tracking?


http://fiji.sc/wiki/index.php/Manual_Tracking

13 Resources

This document is based on

Other

Hands-on Fiji training at the imaging and Microscopy Center at the
Biomedical Core Facility at the Technion, By: Adel Zeidan, Liza Yehiam,
Lior Liba, Edith Suss-Toby

EMBL-CMCI course: Basics of ImageJ Processing and Analysis. By: Kota
Miura (http://cmci.embl.de/mainpages/courses)

Duke Image Analysis Class, By: Sam Johnson

Image processing and quantitative image analysis, Duke University:
http://microscopy.duke.edu/learn/
http://microscopy.duke.edu/learn/IA%20class%20core%20material.pdf
http://microscopy.duke.edu/learn/ImageAnalysis CMB551 2013.pdf

useful resources:

ImageJ workshop at CNRS Montpellier, By Volker Baecker:
http://dev.mri.cnrs.fr/wiki/imagej-workshop

ImageJ User Guide: http://rsbweb.nih.gov/ij/docs/quide/146-19.html

Fiji Wiki page: http://wiki.image].net/Fiji

Fiji Cookbook: http://fiji.sc/Cookbook

Video Tutorial: Installing and Basics of ImageJ:
http://www.youtube.com/watch?v=_zqvo6GBdX8

Analyzing fluorescence microscopy images with ImageJ, By Peter Bankhead,

Queen’s University Belfast:
http://blogs.qub.ac.uk/ccbg/files/2013/06/Analyzing fluorescence microscopy im

ages.pdf

University of Chicago ImageJ/Fiji Help:
http://digital.bsd.uchicago.edu/ImagejandFijiHelp.html

Basics of Image Processing / Analysis:

http://www.Imsc.ethz.ch/Teaching/ipss 2010/MI 1-3 Miura

Colour Analysis Tools in ImageJ:
http://www.fmhs.auckland.ac.nz/sms/biru/_docs/colour_analysis tools in_imagej

odf



http://cmci.embl.de/mainpages/courses
http://microscopy.duke.edu/learn/
http://microscopy.duke.edu/learn/IA%20class%20core%20material.pdf
http://microscopy.duke.edu/learn/ImageAnalysis_CMB551_2013.pdf
http://dev.mri.cnrs.fr/wiki/imagej-workshop
http://rsbweb.nih.gov/ij/docs/guide/146-19.html
http://wiki.imagej.net/Fiji
http://fiji.sc/Cookbook
http://www.youtube.com/watch?v=_zgvo6GBdX8
http://blogs.qub.ac.uk/ccbg/files/2013/06/Analyzing_fluorescence_microscopy_images.pdf
http://blogs.qub.ac.uk/ccbg/files/2013/06/Analyzing_fluorescence_microscopy_images.pdf
http://digital.bsd.uchicago.edu/ImagejandFijiHelp.html
http://www.lmsc.ethz.ch/Teaching/ipss_2010/MI_1-3_Miura
http://www.fmhs.auckland.ac.nz/sms/biru/_docs/colour_analysis_tools_in_imagej.pdf
http://www.fmhs.auckland.ac.nz/sms/biru/_docs/colour_analysis_tools_in_imagej.pdf
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15 Get Prepared

Step 1: Download Fiji (ImageJ)

Go to the Fiji download page: http://fiji.sc/Downloads

Download whichever fits to your OS (in all cases, download “continuous release”).

In Windows OS, you just need to unpack the zip file and place the folder on your
Desktop. With Mac OSX, double click the .dmg file and install it as usual (copy Fiji to
Application folder).

Step 2: Upgrading

Start Fiji. Do [Help—Update Fiji...]. You might need to restart and update several times,
as updater itself is updated first, restart, then plugins.
Do also [Help > Update ImageJ]. This updates the core ImageJ.

Step 3: Install EMBL Sample File Loader:

Download the file “EMBL_sampleimages-1.0.0.jar” from:
https://qgithub.com/cmci/CourseUtil/blob/gh-pages/target/EMBL_sampleimages-
1.0.0.jar?raw=true  and put it in the Fiji plugins folder.

Once you restart Fiji, EMBL will be added to the very right side of the Fiji menu.



http://fiji.sc/Downloads
https://github.com/cmci/CourseUtil/blob/gh-pages/target/EMBL_sampleimages-1.0.0.jar?raw=true
https://github.com/cmci/CourseUtil/blob/gh-pages/target/EMBL_sampleimages-1.0.0.jar?raw=true

16 Useful Shortcuts

+ = zoom-in
- = Zoom-out
5=1:1 zoom

Left Click Drag = Pan: to move the zoomed-in area
Ctrl+Shift+D = [Image—Duplicate]

Ctrl+Z = [Edit—>Und0]

Ctrl+L = Command Finder

CtrI+R = [File—Revert] to original file, useful when undo does not work
[File—Close All] — No shortcut, but still useful
Ctrl+Shift+Z = Channels Tool

Ctrl+l = [Image—Show Info]

Ctrl+Shift+P = [Image—Properties]

Ctrl+M = [Analyze—Measure]

Ctrl+H = [Analyze—Histogram]

Ctrl+K = [Analyze—Plot Profile]

Ctrl+A = [Edit—>Selection—Select All]

Ctrl+Shift+A = [Edit—>Selection—Select None]
Ctrl+Shift+E = [Edit—>Selection—Restore Selection]

Ctri+T = [Edit—>Selection+Add to Manager]



